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1.

Use Accessible Templates
All documents start with a template. These can be as simple as a blank standard sized page or
complex nearly-complete document with text, graphics and other content (e.g. a “Meeting
Minutes” template). Because templates provide the starting point for so many documents,
accessibility is critical. If you are unsure whether a template is accessible, you should check a
sample document produced when the template is used (see Section 10: Checking Accessibility)

1.1

To create an accessible template
1. Create a new document (from the default blank template or from one of the prepackaged
templates available on word)
2. Ensure that you follow all of the techniques in this Guide
3. When you are finished, check the accessible of the document (see xxx)
4. Go to menu item: File > Save As
5. Select Templates
6. In the Save as type list, select Word Template (*.dotx)
7. In the File name box, type a name for the template. Using a descriptive File name (e.g.
“Accessible Memo Template”) may increase the prominence of accessibility status. As well,
filling in the text boxes labeled Tags and Title with the terms that include “accessibility” may
improve the discoverability of the template as an accessible file.
8. Select Save.

1.2

To select an accessible template
Only use these steps if you have an accessible template available (e.g. that you previously
saved). Otherwise simply open a new (blank) document.
1.
2.
3.
4.

Go to menu item: File > New
Select Personal
Select your accessible template from the list.
A new document based on the template will be displayed. If you have chosen an accessible
template, the document will be accessible at this point.
5. As you add your content (e.g. text, images, etc) ensure that you consult the sections that
follow to preserve accessibility).

2.

Specify Document Language
In order for assistive technologies (e.g. screen readers) to be able to present your document
accurately, you must indicate the natural (human) language of the document. If a different
natural language is used for a paragraph or selected text, this also needs to be clearly indicated.
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2.1

To change the default language
1.
2.
3.
4.

Go to menu item: File
Select Options from the list in the left window pane
Select Language from the list in the left of the Options dialog
Under Choose editing Languages, select the editing language from the drop down list [Add
additional editing languages]
5. Select: Set as Default
6. Close all Window documents and open them again for the changes to take effect.

2.2

To turn on automatic language detection
Word has an automatic language detection mechanism, which can automatically detect the
language of your text. If you type a section of text in a different language than the rest of your
document, Word should programmatically mark the language of that section of text
appropriately.
1.
2.
3.
4.

Go to menu item: Review
In the Language section, select the Language button
Select Set Proofing Language
In the Language dialog, select the Detect language automatically check box

3.

Make Content Easier to See

3.1

Format of Text
When formatting text, especially when the text is likely to be printed, try to:







Use font sizes between 12 and 18 points for body text
Use fonts of normal weight, rather than bold or light weight fonts. If you do choose to use
bold fonts for emphasis, use them sparingly.
Use standard fonts with clear spacing and easily recognised upper and lower case
characters. Sans serif fonts (e.g. Calibri, Arial, Verdana are typically easier to read than serif
fonts (e.g. Times New Roman). Note: The University’s preferred font is Calibri.
Avoid large amounts of text set all in caps, italic or underlined
Use normal or expanded character spacing, rather than condensed spacing
Avoid animated or scrolling text.

But can’t users just zoom in?
Office applications do typically include accessibility features such as the ability to magnify
documents and support for high contrast modes. However, because printing is still used by
many and changing font sizes directly will change documents details such as pagination, the
layout of tables, etc, it is best practice to always format text for a reasonable default level of
accessibility.
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3.2

Avoid Relying on Colour or Sensory Characteristics
The instructions provided for understanding and operating content should not rely solely on
sensory characteristics such as the colour or shape of content elements. For example:
1. Do not track changes by simply changing the colour of the text you have edited and noting
the colour. Instead use ‘Track Changes’ feature to track changes
2. Do not distinguish between images by referring to their appearance (e.g. “the bigger one”).
Instead label each image with a figure number and use that for reference.

4.

Make Content Easier to Understand

4.1

Write Clearly




4.2

Introduce acronyms and spell out abbreviations
Avoid making the document too “busy” by using lots of whitespace and by avoiding too
many different colors, fonts and images
If content is repeated on multiple pages within a document or within a set of documents
(e.g. headings, footings, etc) it should occur consistently each time it is repeated.

Alignment of text
Make text left aligned. This makes sure that the spaces between words are consistent making
text easier to read, particularly for partially sighted individuals.

4.3

Orientation of text
All text should be the same orientation on the page. This will make the information easier to
read for partially sighted people and those using magnification software.

4.4

Provide Context for Hyperlinks
Hyperlinks are more effective navigation aids when the user understands the likely result of
following the link. Otherwise, users may have to use trial and error to find what they need. To
help the user understand the result of selecting a hyperlink, ensure that the link makes sense
when read in the context of the text around it.

To add hyperlinks with meaningful text
1.
2.
3.
4.

Type (or past in) a web address and press spacebar or “Enter” to convert into a hyperlink
Select the link and right click
Select Edit Hyperlink (Ctrl + K)
Edit the text in the Text to display box
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5.

Use Headings
Any documents that are longer than a few paragraphs require structuring to make them easier
for readers to understand. One of the simplest ways to do this is to use “True Headings” to
create logical divisions between paragraphs. True heading are more than just bolded, enlarged,
or centered text; they are structural elements that order and levels provide a meaningful
sequence to users of assistive technologies

5.1

Tips for headings




5.2

Use the default headings styles provided (“Heading”, “Heading 2”, …., “Heading 9)
Nine levels of headings are supported in Windows
Nest headings properly (e.g. the sub-headings of a “Heading 1” are “Heading 2” etc)

To apply headings to selected text
1. Select text
2. Right click and select Styles
3. Select the heading style (Heading 1, Heading 2, etc) from the list

5.3

To apply the headings using the Styles toolbar
1. Select text
2. Go to menu item: Home
3. In the Styles section, select the heading style that you wish to apply
Note: You can scroll through the multiple heading styles using the arrows on the right side of the
Styles section. You can also change the Style design by selecting the Change Styles button on
the right.

5.4

To modify heading styles
1.
2.
3.
4.
5.

5.5

Go to menu item: Home
In the Styles section, right click the style you wish to modify from the Styles Gallery
Select Modify
In the Modify Style dialog; make your desired changes to style characteristics
Select OK

Adding heading style that is not listed
Sometimes heading levels may not appear in lists described above. For example, the list might
contain “Heading 1” and “Heading 2”, but not “Heading 3”. In this case, it is still possible to
apply the unlisted style.
1. Select text
2. Go to the menu item: Home
7

3.
4.
5.
6.

6.

In the Styles section, select the arrow to expand the list of style options
Select Apply Styles
In the Style name, enter the heading style (“Heading 1” to “Heading 9”)
Select Apply button

Provide Text Alternatives for Images and Graphical Objects
When using images or other graphical objects, such as charts and graphs, it is important to
ensure that the information you intend to convey by the image is also conveyed to people who
cannot see the image. This is done by adding concise alternative text to each image. If an image
is too complicated to concisely describe in the alternative text alone (e.g. artwork, flowcharts,
etc) provide a short text alternative and a longer description as well.
Alternatively, you can include the same information conveyed by the image within the body of
the document, providing the images as an alternate to the text. In that case, you do not have to
provide alternative text within the image.

6.1

Tips for writing alternative text







6.2

Tips for writing longer descriptions





6.3

Try to answer the question “what information is the image conveying?”
If the image does not convey any useful information, leave the alternative text blank.
If the image contains meaningful text, include all the text in the alternative
Alternative text should be fairly short, usually a sentence or less and rarely more than two
sentences
If more description is required (e.g for a chart or graph) provide a short description in the
alternative text (e.g. a summary of the trend) and more detail in the long description, see
below.
Test by having others review the document with the images replaced by the alternative text

Long descriptions should be used when text alternatives (see above) are insufficient to
answer the question “what information is the image conveying?”
In some situations, the information being conveyed will be how an image looks (e.g.
artwork). In these cases, try to describe the image without making too many of your own
assumptions.
One approach is to imagine you are describing the image to a person over the phone
Ensure that you still provide concise alternative text to help readers decide if they are
interested in the longer description

To add alternative text to images and graphical objects
1. Right click the object
2. Select Format Picture
3. Select the Layout & Properties tab
8

4. Select the Alt Text option from the list under that tab
5. Fill in the Description field (not the “Title” field)

Additional benefits
Sometimes it may not be clear what a particular image is meant to convey and alternative text
can provide that clarity. Also, alternative text has been shown to be included in search engines
rankings which may be of a benefit.

7.

Tables
When using tables, it is important to ensure that they are clear and appropriately structured.
This helps all users to better understand the information in the table and allows assistive
technologies (e.g. screen readers) to provide context so that the information within the table
can be conveyed in a meaningful way.

7.1

Tips for tables









7.2

To insert a table
1.
2.
3.
4.

7.3

Only use tables for tabular information, not for formatting, such as position columns
Use “real tables” rather than text formatted to look like tables using the TAB key or
space bar. These will not be recognised by assistive technology.
Keep tables simple by avoiding merged cells and dividing complex data sets into
separate smaller tables, where possible
If tables split across pages, set the header to show at the top of each page. Also set the
table to break between rows instead of in the middle of rows.
Create a text summary of the essential table contents. Any abbreviations used should
be explained in the summary.
Table captions or descriptions should answer the question “what is the table’s purpose
and how is it organized?”. (e.g. “A sample order form with separate columns for the
item name, price and quantity”)
Table cells should be marked as table headers when they serve as labels to help
interpret the other cells in the table
Table header cell labels should be concise and clear

Go to menu item: Insert
In the Tables section, insert Insert Table
Select the Number of columns and the Number of rows you would like your table to have
Select the Ok button

In set a heading row
1. Place the cursor in the top row of the table that you would like to make into the heading
row
2. The Tables Tool menu item should appear
3. Go to menu item: Table Tools > Layout
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4. In the Table section, select Properties
5. Select the Row tab
6. Select the Repeat as header row checkbox

8.

Use Built-in Document Structuring features

8.1

Lists
When you create lists, it is important to format them as “real lists”. If you don’t assistive
technologies will interpret your list as a series of short separate paragraphs instead of a
coherent list of related items.

To create an order or unordered list
1. Go to menu item: Home
2. In the Paragraph section, select the Bullets icon for unordered lists or select the Numbering
icon for ordered lists

To modify list styles
1. Go to menu item: Home
2. In the Paragraph section, select the arrow beside the Bullets icon for unordered lists or
select the arrow beside the Numbering icon for ordered lists
3. Select Define New Bullet… to create a new unordered list format
4. Select Define New Number Format….to create a new ordered list format
5. In the New Bullet dialog or the New Number Format dialog, select the list characteristics
6. Select OK

8.2

Columns
Use the Columns feature for placing text in columns.
Note: Because columns can be a challenge for some users with disabilities (e.g. people using
magnifiers) consider whether a column layout is really necessary.

8.3

Page breaks
Start a new page by inserting a page break instead of repeated hard returns.

To add a page break
1. Go to menu item: Page Layout
2. In the Page Setup section, select the arrow beside the Breaks icon

10

3. Select the type of break to add. Page break is used to start a new page with the same page
layout (page orientation, headers, page numbering, etc). Section break is used if you want
to start a new section of the document with a differing page layout.

8.4

Table of Contents
Creating an index or table of contents to outline office document content can provide a means
of navigating the meaningful sequence of contents.
The best way to generate a table of contents is after applying the predefined heading styles (e.g.
“Heading 1, “Heading 2) as described above, to the headings that you want to include in your
table of contents. After you apply these styles, you can then create a table of contents.
Note: If you do not want the main title of the document to appear in the generated table of
contents, mark it with the “Title” style.

To insert a table of contents
1.
2.
3.
4.

Place the cursor in your document where you want to create the table of contents
Go to menu item: References
In the Table of Content section, select Table of Contents
Select the style you want to use

To update a table of contents
1. Select the table of contents
2. Go to the menu item: References
3. In the Table of Contents section, select the Update Table button

8.5

Page Numbering
Numbering the pages of your document helps those reading and editing your document
effectively navigate and reference its content. For users of assistive technologies, it can provide
a valuable point of reference within the document.

To insert page numbers
1.
2.
3.
4.

Go to menu item: Insert
In the Header & Footer section, select Page Number
Select where you would like to insert your page numbers
Select the style of page number you would like to use

To format page numbers
1. Go to menu item: Insert
2. In the Header & Footer section, select Page Number
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3. Select Format Page Numbers
4. In the Page Number Format dialog, select the page format characteristics you would like to
use.

8.6

Document Title
If you plan to convert the document into HTML, it should be given a descriptive and meaningful
title.

To change the title of the current document
1. Go to menu item: File
2. Select Info from the list in the left window pane
3. In the right window pane, select the Title textbox and enter an appropriate title
Note: The Title defined in the properties is different to the file name.

9.

Create Accessible Charts
Charts can be used to make data more understandable for some audiences. However, it is
important to ensure that your chart is as accessible as possible to all members of your audience.
All the basic accessibility considerations that are applied to the rest of your document must also
be applied to your charts and the elements within your charts. For example, use shape and
colour, rather than colour alone, to convey information.
When creating line charts, use the formatting options to create different types of dotted lines to
facilitate legibility for user who are colour blind.
When creating bar charts, it is helpful to apply textures rather than colours to differentiate the
bars.
Ensure that the contents of your chart are appropriately labelled to give users reference points
that will help them to correctly interpret the information.
Use the formatting options to change predefined colours, ensuring that they provide sufficient
contrast.
Consider providing the data that you used to create the chart in tabular form (e.g. as an
appendix)

10.

Check Accessibility

12

When you have completed your document or template you should undertake an Accessibility
Check. Use the “Accessibility Checker” provided in Word to review your document against a set
of possible issues that users with disabilities may experience.
The “Accessibility Checker” classified issues as:
Error – content that makes a file very difficult or impossible for people with disabilities to
understand
Warning – content that in most, but not all, cases makes a file difficult for people with
disabilities to understand
Tip – content that people with disabilities can understand, but that might be better organized or
presented in a way that would maximize their experience.

10.1

To use the “Accessibility Checker”
1.
2.
3.
4.
5.
6.
7.
8.

11.

Make sure the file is saved as a DOCX (Older DOC files are not compatible with the checker)
Go to menu item: File
Select Info in the left window pane
Select the Check for Issues dropdown
Select the Check Accessibility item
An Accessibility Checker task pane will open, showing the inspection results
Select a specific issue to see Additional Information
Follow the steps provided to fix or revise the content

Using Accessibility Features when Saving/Exporting to Other Formats
In some cases, additional steps must be taken in order to ensure accessibility information is
preserved when saving/exporting to formats other than the default.

11.1

Saving to PDF
PDF documents are not always accessible. Accessible PDF documents are often called “Tagged
PDF” because they include “tags” that encode structural information required for accessibility.
To evaluate the accessibility of your PDF document, see “Para 10 Check Accessibility”.
1.
2.
3.
4.
5.
6.
7.

11.2

Go to menu item: File
Select Save As
In the File name box, type a name for the file
In the Save as type list, select PDF
Select the Options button
Ensure that the Document structure tags for accessibility checkbox is selected
Select OK and Save

Saving to HTML
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1.
2.
3.
4.
5.

Go to menu item: File
Select Save As
In the File name box, type a name for the file
In the Save as type box, select Web Page
Check the title in the Title textbox. To change it, select the Change Title… to open an “Enter
Text” dialog box
6. Select Save
7. Check the HTML file for accessibility (see 10. Checking Accessibility)
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